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PowerSchool SIS: PowerTeacher Pro
Gradebook

PowerSchool's PowerTeacher Pro Gradebook is a robust classroom
management tool that includes advanced features for both
standards-based and traditional grading. Teachers use the mobile-
friendly gradebook to get their work done and to analyze student
performance.

Accessing the Gradebook

Teachers navigate to the HTML-based gradebook directly through
the PowerSchool SIS Teacher Portal. There’s no need to launch a
separate application to access the gradebook. The first time you
navigate to the gradebook, you’ll see a welcome message that
introduces some of the features.

To navigate to the gradebook:

1. Enter the URL of the PowerSchool SIS server followed by
/teachers

2. Enter your username and password

3. Click Sign In

4. On the teacher portal Start Page, click PowerTeacher Pro
Read the welcome message and click Close
To view the message again, click the Help icon and select Getting

Started. Also click the Help icon to access the PowerTeacher Pro
Help system, and information about new features.

Customizing Class Names and Adding
Class Descriptions

The gradebook includes view-only details about each class you
teach, such as the course name, course number, section humber,
period, term, start date, end date, and associated grade scale. Add
more details about the class, such as a description or the syllabus,
that will be visible in the PowerSchool SIS Student and Parent
Portals, and in PowerSchool Mobile.

Also customize the name of the class if you prefer to use a hame
that is different from the course name. For example, if you teach
multiple Biology classes, customize the names to be different from
each other. Custom class names will appear only in your
gradebook. Co-teachers, students, and parents will not see them.

To customize a class name and add a description:
1. At the top of the gradebook window, select a class

2. In the upper-right corner, select the term in which the class
meets, if different from the current term, or select all terms

3. Click Settings
Select Class Descriptions

The details pane for the selected class opens.

5. To customize the name of the class, enter the name in the
Custom Class Name field
Once you click Save, the custom class name will appear in
the gradebook automatically.

6. Enter the class description, syllabus, or other details in the
Class Description field
Use the editing bar to style the description.

7. Click another class name to open the details pane for that
class and add a custom name or description
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8.

Click Save

Setting Up Display Preferences

Customize the display settings to control how class names appear
in your gradebook—by period and day or by section number.
Additionally, define whether or not to show standards and
traditional grades.

To set up display preferences:

1.
2.
3.
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Click Settings
Select Display Settings

Open the Display and Sorting menu and select an option,
such as Section Number (sort by Course/Custom
Name), to change the way class names appear

When you choose to sort class names by course name or
custom name, classes will be sorted by their course names,
unless you've entered custom class names on the Class
Descriptions page. In that case, classes will be sorted by
their custom names.

Check Show Traditional Grades to display traditional
grades in the gradebook

. Then from the Values to Show in the Traditional Grade

Column menu, select the types of grades you want to see,
such as Grade, Percent, and Points

. Check Show Standards Pages and Links to use the

standards grading features in the gradebook

. Check Show Standards on Assignments to show

standards aligned to assignments in the gradebook

10.

11.

12.

13.

14,

15.

. To make the auto-calculation of standards scores from

assighments scores the default setting when you create a
new assignment, from the Auto-Calculate Assignment
Standards Scores Initial State menu, choose New
Assignments Start Checked

Making this selection will cause the Auto-Calculate
Assignments Standards Scores check box to be selected
by default when you create an assignment.

. To change the sort order of the Traditional and Standards

navigation links in the Grading menu and Quick Menu, open
the Navigation Links Sort Order menu and choose
Standards, Traditional

The default setting is Traditional, Standards.

To display the Professional Judgment Indicator on the
Standards, Standards Progress, and Standards Scoresheet
pages, check Show on Grading (Standards Final
Grades) and Show on Students (Standards Progress,
Standards Scoresheet)

Under Student Names, use the Display menu to define how
students’ names will appear in the gradebook, such as by
first, then last name

Use the Sort Students by menu to choose how to sort the
lists of students, such as by first name

To view new students’ names at the bottom of class lists,
check Add newly enrolled students to the bottom

To conceal the names of pre-registered students from class
lists, check Hide pre-registered students

Click Save
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Changing the Display Text Size

PowerTeacher Pro Gradebook is designed so that you can see
multiple students or assignments in a compact view by default.
However, you can zoom in by changing the text size.

To change the size of the text:

1. Click the User menu (a circle with your initials in it) in the
upper-right corner

2. Under View, select Medium or Large

To decrease the text size to the default size, select Small.

Setting Up Grading Preferences

Administrators may choose to set up the grading preferences at
the district or school level for all teachers. However, if they are
permitted to do so by their district and school leaders, teachers
may define some of the grade calculations for the classes they
teach. Provided you have permission to do so, set up the grade
calculations for one class. Then save time by copying the
traditional grade calculations across classes and reporting terms.

If you changed the default grade calculation formula set by the
school or district, you can revert back to the default settings by
clicking Revert to Default in the class heading. If you do not see
the button, that means you have not modified the default settings.

Additionally, administrators may make alternate grade scales
available for teachers and administrators to assign to individual
students. If you have permission to do so, assign alternate grade
scales to students who need to be graded using a grade scale
that's different from the scale assigned to the class. For example, a
student may have an IEP that specifies the use of an alternate
grade scale.

If administrators have given you permission to create or modify
class grade scales, you may also edit the grade scales used by all
of the students in one or more of your classes.

Traditional Grade Calculations

To define a traditional grade calculation for a class:

1.
2.
3.

12.
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Click Settings
Select Traditional Grade Calculations

To see the grade calculations for all of the classes, click
Expand All

For one of the classes in the list, click the Edit icon next to
the first reporting term

. To calculate the overall class grade using the formula, verify

that Calculate Overall Class Grade is checked

. Open the Type menu and choose a calculation type, such as

Category Weighting

. Open the Attribute menu and select a category, such as

Homework

. To define the weight of the selected category, enter a value

in the Weight field, such as 2 (for 20%)

. To include another category, click the + sign
10.
11.

Open the Type menu and choose Category Weighting

Open the Attribute menu and select a different category,
such as Quiz

To define the weight of the selected category, enter a value
in the Weight field, such as 3 (for 30%)
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13.

14.

Repeat steps 9-12 to set up weighting for two more
categories

Use weight values that will make the values in the Percent
columns add up to 100%.

To save the grade calculation, click Save

Set up the grade calculations for the remaining reporting
terms. If you do not have access to edit the grade
calculation preferences, follow your school and district
policies or contact your PowerSchool SIS administrator.

To define a traditional grade calculation that includes specific
weighting for course standards:

1.
2.
3.

Click Settings
Select Traditional Grade Calculations

To see the grade calculations for all of the classes, click
Expand All

For one of the classes in the list, click the Edit icon next to
the first reporting term

. To calculate the overall class grade using the formula, verify

that Calculate Overall Class Grade is checked

Open the Type menu and choose Standards Weighting as
the calculation type

From the Attribute menu, choose Specific Weights

8. Click the Specific Weights tab

9.

If your school or district leaders have enabled editing rights
for you, modify the values in the Weight column to change
the weight of course standards

If you have not been given permission to edit the weights,
you will be able to only view the specific weights set for the
course at the district level.

10. To save the changes, click Save

Standards Grade Calculations

To define standards grade calculations:

1.
2.
3.

7.

Click Settings
Select Standards Grade Calculations

Define how standards grades will be calculated from
assignment scores by default, for example, choose Most
Recent Scores

Define the number of recent scores to include in the
calculation and their relative weighting by clicking the Edit
icon, choosing the number of scores, and modifying the
values in the Weight column

. To automatically calculate higher-level standards grades

from lowest-level standards grades, check Auto-Calculate

Select the metric that will be used in the calculation, such
as Mean

Click Save

Copying Traditional Grade Calculations

To copy traditional final grade calculations:

1.

Copyright © 2021 PowerSchool Group, LLC or its affiliates. All rights reserved.

Click Settings



PowerSchool SIS: PowerTeacher Pro Gradebook

Quick Reference Card

Select Traditional Grade Calculations

In the upper-right corner of the Traditional Grade
Calculations page, click the Gear icon

Select Copy Traditional Grade Calculations

5. At the top of the Copy Final Grade Calculations window,

select Within A Class to copy the settings from one
reporting term to another within the same class

In the From area, open the Class menu and choose the
class from which you want to copy the calculations

In the From area, open the Reporting Term menu and
choose S1 as the term from which you want to copy the
calculations

In the To area, open the Reporting Term menu and
choose S2 as the term to which you want to copy the
calculations

If you are changing traditional grade calculation settings for
the target class and want to recalculate any existing grades,
check Recalculate Final Grades.

. Click Validate
10.

Review the summary to ensure that you are copying the
correct settings, then click Copy

The alert at the top of the window indicates that the
settings were copied successfully.

Reverting to Default Calculation Settings

To revert to the district or school default settings:

1.

Click Settings

Select Traditional Grade Calculations or Standards
Grade Calculations

In the class heading(s), click Revert to Default

Revert to Default

The Revert to Default button will not be visible after you
revert to the default settings.

v P1(A-B) ALGEBRA 1

Assigning an Alternate Grade Scale to a
Student

To assign an alternate grade scale to an individual student:

1.
2.
3.

Click Settings
Click Student Grade Scales

Locate the section the student is enrolled in and click the
section name

To add a student grade scale, click Add

From the Choose Grade Scale menu, select the alternate
grade scale

6. Check the box to the right of the student's name
7. Click Save
8. To confirm the change, click Save Changes
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New assignment scores that you enter for the student will
be based on the alternate scale. To update previously
entered scores, recalculate final grades by following the
steps for recalculating final grades in this document.
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9. On the Student Grade scales page, view, modify, or remove
grade scales assigned to individual students

Note: When a student has been assigned an alternate grade
scale, the Scoresheet will include a gold triangle in the
name cell for that student.

STUDENTS (25) GRADE

1. BISHOP, Donovan 3 92.25%
2. BLACK, Perisa B 86.75%
3. CAMPBELL, Butler B 85.91%

Creating and Modifying Class Grade Scales

District or school administrators may give teachers permission to
modify existing class grade scales or to create new ones for their
classes. This provides the flexibility to accommodate various
grading policies and is similar to functionality in a legacy
PowerSchool product, PowerTeacher Gradebook.

If you choose to use the Class Grade Scale feature, it should be
part of the setup at the beginning of the school year before class
begins and before grades are entered. PowerSchool strongly
recommends that this feature is not enabled or changed during the
school year.

If you have permission to do so, you can access and adjust class
grade scales for your classes. You can edit the cutoff points, grade
values, and color levels, and choose to ignore specific grades in the
grade scales assigned to your classes.

To create a custom grade scale:
1. Click Settings
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2. Click Class Grade Scales
Click a class grade scale name to open the details pane.

The Class Grade Scales page provides a user-friendly
summary to view the grade scales assigned to classes, even
when the custom grade scales feature is not used or
enabled.

3. Click Create Custom

This option is available only if enabled and the feature is not
locked, as shown by the Schoolhouse icon, and the term is
not locked, as indicated by the Lock icon.

4. In the Custom Grade Scale window, enter a name for the
custom grade scale and select the available classes to apply
this custom grade scale

5. Click Create

The new grade scale will appear below the existing grade
scale.

6. Scroll down to the new grade scale and edit the cutoff and
grade values, color levels, or choose grades to ignore

7. Click Save

After you create a custom grade scale, you can modify it by
clicking Modify. You can change the name of the custom grade
scale, apply it to more classes, delete it, or modify the cutoff and
grade values, color levels, and ignored grades. Then click Save.



PowerSchool SIS: PowerTeacher Pro Gradebook

Quick Reference Card

Note that if you change or modify the class grade scale settings
after grades are entered, you will be prompted with the option to
recalculate the final grades for applicable classes. If you delete the
custom grade scale after grades are entered, the deletion will force
a recalculation of assignment scores and final grades for the
associated sections and you will be prompted with a choice to
proceed or not.

Here are some additional points to keep in mind when using class
grade scales:

e Co-teachers can create class grade scales for their classes if
they have edit access to the classes

e Class grade scales do not roll over year to year

e Only one class grade scale can be associated with a class

Working with Assignments

Before you begin creating assignments, it's recommended that you
create categories so you can group assignments by type. Then, set
up assignments in the gradebook, choose whether or not to include
them in students' final grades, and tie them to standards. Your
district leaders may also set up assignment categories at the
district level for you and other teachers to use.

Creating Categories

Categories are broad classifications in which you group similar
types of assignments. Examples of categories are homework, tests,
and quizzes. Set up your own categories, or use district-created
categories. District-created categories are identified by a
Schoolhouse icon next to the category name.
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To create an assignment category:

1. Click the Create icon

2. Select Category

3. On the Category tab, open the Select Classes menu and
select the class or classes in which you will use the category
By default, the category is available to all classes.

4. Enter the name of the category, such as Test
Select a color for the category, such as Red
Use the default status of Active
Check Inactive when you want to make categories that you
no longer use inactive.

7. Enter a description of the category, such as Use for test
assignments

Click the Assignment Defaults tab

9. Use the Publish Assignment menu to define when
assighments in this category will be published

10. To publish the scores of assignments in this category by
default, verify that Publish Scores is selected

11. Select the default score type that assignments in this
category will use, such as Points
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12.To include extra points in the assignments by default, click

Extra Points and enter the number of extra points, such as
5

13. To weight assignments in this category by default, click
Weight and enter a value, such as 2, in the X Weight field

14.1n the Score Entry Points field, enter the number of points
that assignments in this category will be worth by default,
such as 100

15.To include assignments in this category in final grade
calculations by default, verify that Count in Traditional
Final Grade is selected

16.To save the new category, click Save

Creating and Viewing Assignments

View assignments on both the Assignments and Scoresheet pages.
Set up assignments at the beginning of a school term or at any
time during the term. To save time, duplicate existing assignments
or create duplicates while creating a new assignment.

To create an assignment:
1. Click the Create icon
2. Select Assignment
3. Open the Select Classes menu and select a class

Click outside the Select Classes menu to close it.

4. Enter the name of the assignment, such as Unit 1 Test
Select Test as the category
Enter the assignment due date

The default due date is today’s date.
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10.

11.
12.

13.

14

17.

18.

Select a score type, such as Points
Enter the number of score entry points, such as 80

9. To include the assignment in students’ final grades, verify

that Count in Traditional Final Grade is selected

Enter a description, such as This test covers all of the
topics in Unit 1

Click the Students tab
Verify that the assignment applies to all students
To apply the assignment to a selection of students, click

Show All. Then clear the check box next to the Filter area
and check the boxes next to the selected students’ names.

Click the Standards tab

. Select the standards that are aligned to the assignment
15.
16.

Click the Publish tab

Open the Publish Assighnment menu and choose when to
publish the assignment for students and parents

To publish students’ scores once you’ve scored the
assignment, check Publish Scores

Click Save and Close at the bottom of the Create window
Instead of closing the edit window, you could also copy the

assignment by clicking Duplicate at the bottom of the
Create window.

Score the new assignment immediately by clicking Score
Assignment in the alert at the top of the window.

;/ Assignment: Unit 1 Test created successfully. Score Assignment X
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To edit an assignment:

1. Click Grading and select Assignment List

2. Locate the assignment and click the Edit icon

3. Modify the assignment details and save the assignment
To duplicate an assignment for use in another class:

1. Click Grading

2. Select Assignment List

3. In the list of assignments, locate an assignment that you've
already created and click the Edit icon

4. Click Duplicate at the bottom of the Edit window

Open the Select Classes menu, clear the check box next to
the currently selected class, and choose a different class

Click outside the Select Classes menu to close it.

6. Edit the duplicated assignment name by deleting the
underscore and number that were appended to the end

7. Use the same category, due date, score type, score entry
points, description, and publication settings as the original
assignment, or modify the values as needed

8. Click the Standards tab

Click Show All and, if needed, select a new set of
standards that are aligned to this assignment

10. To save the assignment and close the Edit window, click
Save and Close

11.To verify that you copied the assignment to a different
class, click the name of the currently selected class in the
navigation bar at the top of the page and select the class
that you copied the assignment to

12. Locate the duplicated assignment in the list of assignments

Copying Assignments

As a lead teacher or a co-teacher, copy one, some, or all of the
existing PowerTeacher Pro assignments in a selected term and
class to other terms and classes using the Copy Assignments
feature. Use the existing due dates, a custom due date, or
proportional due dates relative to the selected term. Also, copy all
of the assignments from a legacy PowerTeacher Gradebook class to
a PowerTeacher Pro Gradebook class.

If a Lock icon appears at the top of the assignment column, the
reporting term or class is locked. You are unable to copy an
assignment to a locked term or class.

To copy assignments from a Semester 1 class to a Semester 2
class:

1. From the Assighments or Scoresheet pages, click the Gear
icon to the left of the Term menu

Click Copy Assignments

Under From Class, open the Term menu and select
Semester 1

4. Under From Class, open the Class menu and select the
class from which you want to copy the assignments

5. Under To Class, open the Term menu and select Semester
2

6. Under To Class, open the Classes menu and select the
class or classes to which you want to copy the assignments

7. Under Copy Options, open the Due Dates menu and choose
whether you want to use existing, relational, or custom due
dates
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8. Under "Choose the Assighments," check the box to the left
of the Category heading to select all of the assignments, or
check individual boxes next to the assignment names to
choose a smaller selection

If the source class you selected is a PowerTeacher
Gradebook class, all assignments will be copied to the
classes you select.

9. To complete the process, click Copy Assignments

Be sure to edit the due dates of the copied assignments.

Working with Grades

When entering scores, make sure to use the type of score that you
set up when you created the assignment. For example, use
numbers for points and percentages or letters for letter grades.

To enter scores:
1. Click Grading
2. Click Assignment List or Scoresheet

3. From the Assignments or Scoresheet pages, enter a
student’s assignment score by clicking in the cell where the
student’s name intersects with the assignment name and
type in the score

Navigate sideways through the score columns by clicking
the left- or right-facing arrows at the end of the rows.

View the summary above the list of assignments to see the
selected assignment’s score type, as well as the student’s
existing score (if the assignment was previously scored),
and the due date.

In the summary, click Edit Assignment to edit the
assignment details. Click Show More to view additional
information, such as the associated grade and special codes
scales.

Assignment: Spelling Project
Score Type: (A-F)

Score: D | 69% | 69/100 Due: 4/29/2021

To view additional metrics for a selected assignment on the
Assignments page, or for all assignments on the Scoresheet page:

1. Click the Gear icon at the top of the page

2. Click Show Metrics to view the mean, median, and mode
statistics for the assignments or for the aligned standards

Using the Score Inspector and Flags

While you can enter scores manually, use the Score Inspector to
provide more details about the student’s performance, such as
when a student has a missing or late assignment. Also use the
Score Inspector to enter a comment about a student’s score.

Copyright © 2021 PowerSchool Group, LLC or its affiliates. All rights reserved. 10



PowerSchool SIS: PowerTeacher Pro Gradebook

Quick Reference Card

Your district leaders may have associated a special codes scale to
the regular grade scale. If that is the case, you can click Codes in
the Score Inspector and select a special code, such as NC for no
credit, to score a student’s assignment. In some cases, you may
also see other system-generated icons that are related to
standards grades.

To open the Score Inspector, click in a score cell on the
Assignments or Scoresheet pages.

The following table provides brief explanations of the flags (score
indicators) and other icons available in the gradebook.

Flag or Icon

Description

Indicates that an assignment wasn’t completed
due to the student being absent

Indicates that an assignment is incomplete

Flag or Icon

Description

Indicates that an assignment was collected

=

Indicates that a comment was added

2D

Indicates that an assignment is late

Indicates that evidence exists for mastery that
may differ from a student’s calculated standard
score

Indicates that an assignment is missing

Indicates that the standard grade is auto-
calculated from the lower-level standards scores

Indicates that an assignment is exempt

g | |

Indicates that the assignment score is used to
auto-calculate the scores for the standards
aligned to the assignment

Copyright © 2021 PowerSchool Group, LLC or its affiliates. All rights reserved.
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Filling Scores

Use the Fill functions to either fill scores for one assignment for all
of the students in a class, or to fill all assignment scores for one
student. Scores will be filled in cells that do not already have
scores. Additionally, use the fill scores functions to fill comments.

To fill students’ scores for one assignment:

1. For the selected assignment, click in a score cell on the
Assignments or Scoresheet pages

2. Enter the score or select the flag in the Score Inspector
3. Click the Fill icon with the vertical arrows
4. Save the scores

To fill multiple assignment scores for one student:

1. For the selected student, click in a score cell on the
Assignments or Scoresheet pages

Enter the score or select the flag in the Score Inspector
Click the Fill icon with the horizontal arrows
Save the scores

Importing Personal Comments from
PowerTeacher Gradebook

If you used the legacy PowerTeacher Gradebook previously, import
your personal comments to PowerTeacher Pro Gradebook so that
you don't have to create them manually. Keep in mind that you can
import comments only once and only until you create your first
PowerTeacher Pro comment.

If you have already created PowerTeacher Pro comments but would
like to import your PowerTeacher Gradebook comments, delete the
comments you created in PowerTeacher Pro to view the import
option again.

To initiate the import, first click Settings. Then click Comment
Bank. On the Comment Bank page, click Import my PTG
Comments. PowerTeacher Pro comment codes are limited to 10
characters, comment categories are limited to 30 characters, and
the comments are limited to 500 characters. Any PowerTeacher
Gradebook comment exceeding these limitations will be truncated
during the import. If any of your PTG comments exceed the
limitations, you will see a warning. Click Yes to proceed. Once the
import is complete, your personal comments appear on the My
Comments tab of the Comment Bank settings page and are
available for use in the Score Inspector.

Adding Personal Comments to the Comment
Bank

Use the Comment Bank settings page to add personal (teacher-
created) comments to the comment bank to use when scoring
assignments or adding final grade comments for report cards. Use
smart text options to include names and pronouns in comments to
personalize the comments for individual students.

Also use the Comment Bank settings page to edit or delete
personal comments, or to identify your favorite personal or district
comments. To mark a comment as a favorite, click the Star next to
a comment on either the My Comments or District Comments tab.
Your favorite comments will appear at the top of the list of
comments in the Score Inspector.

To add a personal comment to the comment bank:
1. Click Settings
2. Click Comment Bank
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3. On the My Comments tab, click Add

Enter a comment code, such as 01

When you use the fill functions to fill comments that include the
student’s name or any gender pronouns, PowerTeacher Pro detects
this and you have the choice of applying the smart text to the
comment for each student or using the original text. For example,

Comment codes are limited to 10 characters. if you enter a comment for one student that says, James

5. Enter a comment category, such as Study Habits completed all assignment tasks, fill the comment for other
students, and select Use Smart Text, each student’s name will be
Comment categories are limited to 30 characters. personalized in the resulting comments.
6. To mark this comment as one of your favorites, check To enter a comment:
Favorite 1. Click the Comment icon in the Score Inspector
7. Open the Insert Smart Text menu and choose <first . . .
name> to insert it in the Comment field 2. Either enter a comment in the text box, or click Show
Comment Bank
8. Enter the rest of the comment after the smart text, such as . . . C
consistently completes homework on time 3. Click the Gear icon and choose either the District
Comments or My Comments bank
Comments are limited to 500 characters.
9. Click Save Also choo_se to se_parate comments by a I|_ne break or a
space. Click outside of the menu to close it.
Your personal comment is listed on the Comment Bank 4. Click the + sign next to a comment to select it
setting page and will appear in the comment bank in the
Score Inspector. A blue Comment icon appears in the student’s score cell.
. Click Save
Entering Comments _ _
Click the icon to read the comment
As you enter scores or flags for assignments, use comments to Click Clear Comment to remove it from the score
record specific details about student performance. Add comments
manually or choose comments from the comment bank. Click the CHAPTER 1 ABULZ
Star icon next to a comment in the bank to set it as one of your v v
favorite comments. 1. Ainsworth, Cole c 79% F D
2. Braton, Kelly B 86% B u B
3. Brooks, Nicholas A 91% c A

To fill comments, enter a comment for one student and click the
Fill icon. Then choose to fill comments only or to fill scores, flags,
and comments.
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Scoring Assignments

Use one of two methods to score an assignment—score a single
assignment from the Assignments page, or score multiple
assignments on the Scoresheet.

To enter scores, flags, or comments for a single assignment:
1. Click Grading
2. Select Assignment List
3. Click the name of an assignment
4. Click in a student’s score cell and type a score, such as 72

View the assignment summary above the list of students to
see which score type to use.

Click the Comment icon in the Score Inspector

6. Enter a comment, such as Needs to turn work in on
time

7. Click the right-facing Score Arrow in the Score Inspector
to move to a standards score cell (if standards are aligned
to the assignment)

8. Enter a standards score for the student
View the assignment summary above the list of students to
see which grade scale type to use. Hover your cursor over a

standard identifier to view the name and description of the
standard.

9. Save the scores

To enter scores, flags, or comments for one or more assignments
on the Scoresheet:

1. Click Grading
2. Select Scoresheet

3. Click in a student’s blank score cell for the selected
assignment and enter a score in the Score Inspector

4. Click the Vertical Fill icon to fill all of the blank score cells
with the score you entered in the Score Inspector

5. In the alert window that lists the number of scores that
were filled, click Ok

6. Click in a different student’s score cell for a different
assignment and click the Exempt flag

7. Click Save

When you delete or edit a score, a small gear icon appears next to
the values in the student’s Grade column because they are being
edited. Once you save the changes, the student’s grades will be
recalculated using the new score.

Using Minimum Assignment Values

Some schools require a minimum grade value to be awarded for
any assignment score. The Minimum Assignment Value
functionality forces assignment scores assigned a traditional grade
to be no lower than the minimum value, which is a percentage,
regardless of the score entered by the teacher. If your school has
set up this policy, when scoring assignments you will see both a
max entry and min entry value. For example, if an assignment is
worth 100 points and the minimum value has been set to 50%, the
max entry is 100 and the minimum entry is 50. If you were to
enter a score of 43 and click Save Scores, the value will
automatically be entered in the scoresheet as 50.

Auto-Calculated Assignment Standards

When new standards are added to a previously graded assignment
that has its standards auto-calculated, those new standards will
have their scores auto-calculated. In versions prior to PowerSchool
SIS 20.11, adding standards would not automatically impact the
score and the scores would be blank.
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If you don't want scores for the newly added standards to be auto-
calculated, within an assignment, on the Standards tab, clear the
Auto-Calculate Assignment Standards Scores check box to
remove this option.

Previewing Grades

There are times when you may want to see how a particular score
on an assignment will affect a student's final traditional and/or
standards grades without having to save the scores. For example,
a student may ask you what score they need to earn on a final
exam to bring their grade up from a D+ to a C.

In PowerTeacher Pro, use the Preview Scores function on the
Scoresheet, Standards Final Grades, All Reporting Terms, (student)
Assignments, and Standards Scoresheet pages to preview how
unsaved assignment scores will affect students' final grades. The
Preview Grades button appears once a grade change is made, but
not until then.

To preview grade changes:
1. Click Grading and select Scoresheet

2. Locate the student and the assignment you want to work
with

3. Click in the student's assignment cell and enter a grade or
modify the existing grade

4. Click Preview Grades

If there are existing standards scores, choose whether to
adjust or keep the scores

6. Review the changes to the student's final grade

The cells that contain data that has changed are outlined in
blue.

7. To exit the preview and view the existing grade, click
Cancel Preview

No changes to the student's final grade will be made unless
you click Save.

Copying and Transferring Scores

As a busy teacher, you can sometimes make mistakes like entering
scores for the wrong assignment in your gradebook. Or, you may
have students switch between two classes that you teach.

Copying and Pasting Scores

Fix score entry mistakes or transfer scores by copying and pasting
scores or grades from one assignment to another, or from one
class to another class with the same students in different reporting
terms. Use the Assignments, Scoresheet, or Standards Grades
pages to copy and paste scores or grades. However, keep the
following rules in mind:

e You cannot replace scores or grades that use a different
score type than the original

e When pasted to a column with different grade scales or total
points, scores and grades are not converted to the new
grade scales or total points

e If the list of students is different between the original
assighment scores and the assignment being copied to, only
scores for students who are in both classes will be updated

e You cannot paste into the assignment score column on the
single assignment scoring page when an assignment is set
to auto calculate standard scores

e You are unable to copy scores and grades to a locked term
To copy and paste scores or grades:
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1.

5.

On the Scoresheet or Standards Grades pages, click the
assignment score column heading

Choose Copy

Locate the assignment you wish to paste to and click the
score column header

Then choose Paste

All updated scores and grades are highlighted.
Save the scores

Transferring Scores

When a student transfers into your class or moves between two
sections of a class you teach after the term has started, you can
copy the assignment scores from the student's dropped class into
the new class. However, keep the following rules in mind:

Only assignments with scores for the selected student in the
dropped class are available to be transferred

Assignment scores, standards scores, assignment
comments, and assignment flags are saved as part of the
transfer process

Comments from the teacher who taught the dropped class
will be listed with that teacher's name at the end of the
comment

When transferring scores to an assignment using a different
grade scale, percentages are copied, points are adjusted as
needed, and letter grades are calculated based on the grade
scale used by the student's new class

Scores from any term can be copied, even if the previous
term is locked

Scores can be copied to any term, except to a locked term

To transfer assignment scores from a student's dropped class:

1.
2.

Copyright © 2021 PowerSchool Group, LLC or its affiliates. All rights reserved.

Click Students

Select the student who transferred into your class

Students who enrolled in the class after the term's start
date are labeled with "New student as of [date]" under their

names. The label will be present for only two weeks from
the student's class enroliment date.

Open the Quick Menu and select Transfer Scores
If you are viewing the student's Assignments page, click the
Gear icon and choose Transfer Scores.

To use the filter options to limit the number of assignments
that appear on the page, click the Gear icon, select Show
Filter, and use the filter options

Open the From Class menu and select the dropped class

Open the To Class menu and select the class you want to
copy the scores to

Open the From Term menu and select the term you want
to transfer scores from

Open the To Term menu and select the term you want to
copy the scores to
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9. Use the To Class Assignment column to map the
assignments

If the assignment ID or assignment nhame matches between
the From Class and To Class columns, the matching
assignment appears in the To Class column automatically.

If there are multiple assignment names that match between
the From Class and To Class columns, but there is one
unique due date match among the multiple exact nhame
matches, the assignment with the matching due date
appears in the To Class column automatically.

If there are no matching IDs or names between the From
Class and To Class columns, then no suggested assignment
appears, but you can browse available assignments and
select one to map the scores to.

10. To view the details and any potential issues about the
scores you are transferring, click Details

11.To complete the process, click Transfer Scores

Exporting and Importing Assignment Scores

When you need to score an assignment offline, such as when you
have a parent volunteer score an assignment, export the
assignment into a spreadsheet. Then record the students' scores in
the spreadsheet and use it to import the scores into PowerTeacher
Pro. If the reporting term or class is locked, you are unable to
import scores.

To export and import assignment scores:
1. Click Grading
2. Select Assignment List
3. Click the name of the assignment

Copyright © 2021 PowerSchool Group, LLC or its affiliates. All rights reserved.

10.
11.

12.

13.

14,

In the upper-right corner of the assignment page, click the
Gear icon

Select Export Scores Template
If there are any existing assignment scores, choose whether

or not to include the scores in the exported file by clicking
Yes or No in the Export Scores Template window.

Open the exported file
The top of the spreadsheet includes the teacher's name,
class, assignment name, due date, points possible, extra

points, and score type. Below the assignment details are
three columns—Student Number, Student Name, and Score.

Enter the students' scores in the Score column and save the
spreadsheet as a .csv file

In PowerTeacher Pro, navigate back to the assignment
page, click the Gear icon, and select Import Scores

In the Import Scores window, click Browse Files
Select the spreadsheet file

In the Format menu, use the default selection of
PowerTeacher Score Template

Check Validate Student Names to verify that the student
names in the import file match the names of the students
enrolled in the class

Click Next

Review and correct any import errors.

To import and save the scores in PowerTeacher Pro, click
Import
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Working with Final Grades

Final grades are updated automatically throughout the term as you
enter assignment scores in the gradebook. When the term comes
to a close, however, you may have additional tasks to perform
before submitting grades for report cards to make sure that your
final grades are accurate. For example, you may have to enter
standards grades, modify individual scores, or enter citizenship
grades. Occasionally, you may also need to modify a student’s final
grade in a course based on effort, participation, or other
performance factors.

To work with final grades, click Grading and use the links in the
Grades section. Access the same links by opening the Quick
Menu—the arrow next to the heading at the top of the grading
pages.

Grades: Traditional - S2

Areas

Traditional

Standards
Comment Verification
Category Totals

All Reporting Terms

Modifying Final Grades
To modify a final grade:

1. Click Grading

2. Click Traditional

3. Click a student’s final grade

Copyright © 2021 PowerSchool Group, LLC or its affiliates. All rights reserved.

10.

In the Score Inspector, edit the student’s grade

For example, change a letter grade of A- to A, and a
percentage of 91 to 94.

. Click Save

Notice that the student’s final grade cell has a small triangle
in the upper-left corner, which indicates that the grade has
been modified manually.

1. Ainsworth, Cole A 95%

6. Open the Quick Menu and select Standards
7. Click a standards grade for the same student

In the Score Inspector, click the Graph icon to open the
view-only standards progress graph for the selected
standard and student

The progress graph shows how the student performed on
the standard over a period of time. Use the arrows in the
Score Inspector to move between progress graphs for the
selected student. To open the student's Standards Progress
page to change assignment scores, you could click Show
More at the top of the graph. Learn more about the
Standards Progress page in the Analyzing Performance
section of this document.

. Click the Graph icon in the Score Inspector again to close

the progress graph

On the Standards page, edit the student's final standards
grade

For example, change a score of 3 to 4 or a score of M to E.
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11. Click Save

To revert to the calculated grade, click the Undo icon in the
Score Inspector. To view additional standards metrics, click
the Gear icon at the top of the page and then select Show
Metrics to view the mean, median, and mode statistics.

Viewing Dropped Students

When working with final grades, if you need to view, modify the
final grades for, or enter comments about the students who have
dropped your class, do so from the Traditional grades page.

To view dropped students:
1. Select the class the student was in
2. Click Grading
3. Click Traditional
4. Click the Gear icon and select Show Dropped Students

Entering Citizenship Scores

If your school doesn't track behavior through standards, then your
district leaders may enable citizenship score entry and set up a
citizenship scale that includes codes like S for Satisfactory or N for
Needs Improvement for you to use in PowerTeacher Pro.

To enter citizenship scores:
1. Click Grading
Click Traditional
Click in a student's cell in the Citizenship column
In the Score Inspector, select a citizenship score, such as S
Click Save

A W

STUDENT (19) Q4 CITIZENSHIP
1. Bailey, Jenilyn B- 82% H
2. Brito, Jordan B+ 88% S
3. Bushman, Joshua A- 92% H

Awarding Variable Credit

If you teach at a school that has an alternative education program
or any sections in which students can earn variable credit hours for
a course, your school administrator can set up PowerSchool SIS so
that you can enter variable credit for students in PowerTeacher
Pro.

Using variable credit, teachers can specify how much credit each
student attempted (potential credit) and how much credit each
student is awarded (earned credit), regardless of the credit hours
specified for the course or the grade the student earned for the
class in a term.

To enter awarded and attempted variable credit:
1. Click Grading

2. Click Traditional
3. Click in a student's cell in the Awarded column
4. Enter the number of credits the student earned, such as .5
5. Click in the same student's cell in the Attempted column
6. Enter the number of credits the student attempted,
such as 1
7. Click Save

Note: If your school's transcripts include only awarded credit, then
you'll see only one column for entering the credit values in
PowerTeacher Pro.
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Recalculating Assignment Scores and Final
Grades

Although grades in PowerTeacher Pro are calculated automatically,
you can force a recalculation, if necessary. Use the recalculate tool
after making significant changes in the gradebook, such as adding
multiple assignment scores for students who transferred from
another class. Also, recalculate scores and grades when your
PowerSchool SIS administrator changes a setting that affects the
gradebook, such as the grade calculation formula or grade scale, or
when you assign an alternate grade scale to a student.

To use the recalculate tool:
1. Click Grading
2. Select Traditional
Or select Scoresheet, Standards, Comment
Verification, Category Totals, or All Reporting Terms

under Grading. Under Students, click Assignments,
Standards Progress, or Comment Log.

Click the Gear icon
Select Recalculate Final Grades
Select the classes in which you are recalculating grades

o v kAW

To recalculate traditional grades, check Traditional Final
Grades

7. To recalculate standards scores, check Standards Final
Grades

8. To update existing assignment scores, open the Advanced
Options pane and check Refresh Assighment Scores

The option to refresh assignment scores will include
traditional, standards, or both types of scores depending on
which types of final grades you choose to recalculate.

Recalculate assignment scores only when your PowerSchool
SIS administrator changes the grade scale.

If you choose to recalculate final standards grades and
standards grades are auto-calculated, be aware that any
grades you've entered or changed manually will be
overwritten.

9. C(Click Recalculate

Submitting Final Grades

At the end of the term, notify your school’s PowerSchool SIS
administrator that you have finished entering the scores for the
term and that final grades are ready to be stored.

1. Select a class and verify that you are in the correct term
2. Click Grading
3. Select Traditional

Or select Standards or Comment Verification.
4. At the bottom of the page, click Final Grade Status

5. When you have completed your final grades, check [Term]
Final Grades are Complete
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6. Enter a comment indicating that final grades are complete,
and click Save

The green check mark next to "Final Grade Status" indicates
that final grades are complete.

/ Final Grade Status

If you aren’t done with final grades yet, leave the check box
clear, enter a status comment, and click Save. Remember
to submit final grades for each class you teach.

Understanding Locked Reporting Terms

At the end of a reporting term, your PowerSchool SIS administrator
may choose to lock the reporting term to prevent changes to
grades so that the grades in teachers' gradebooks remain the same
as the grades that have been stored in PowerSchool SIS and
included on report cards. Your PowerSchool SIS administrator will
define the dates on which reporting terms will be locked. Once a
reporting term is locked, you will not be able to change final
grades, assignment scores, or assignments that have been scored.
Additionally, if you recalculate final grades, grades in any locked
terms will not be recalculated.

If your school or district leaders decide to lock reporting terms, you
will see warning messages at the top of PowerTeacher Pro pages,
such as the Assignments and Scoresheet pages.

e Before the reporting term is locked, you will see a warning
message indicating when the reporting term will be locked

For example, you may see a message that says the
reporting term will be locked in five days. Be sure to
complete final grades before the end of the lock date.

e Once a reporting term has been locked, you will see a
message indicating that the term is locked

If you attempt to score an assignment or a standard aligned to an
assignment that has a due date in a locked term, you will also see
a message in the Score Inspector indicating that the score is
locked.

What if you need to correct a final grade after a term is locked? If
you need to change assignment scores or final grades after a
reporting term has been locked, contact your PowerSchool SIS
administrator. Your administrator can temporarily unlock one or
more of your classes so that you can make the necessary changes.

Analyzing Performance

Use the gradebook to analyze student performance at any time
during the school year. Analyze performance throughout the term
to ensure that students are mastering the skills and standards that
you are teaching. Review students’ performance as you prepare to
complete final grades for report cards, and then use the gradebook
to prepare for and conduct parent-teacher conferences.

Review how students in an entire class are performing using the
Progress pages. The individual student pages provide helpful
information during parent-teacher conferences to explain why a
student earned a particular grade.

Student
View Page

Description

Use the Assignments page to view a summary of a
student’s grades and assignments for the selected
reporting term. The Assignments student page is
similar to the Assignments page you view for the
entire class, except that it shows only the
assignments and scores for the selected student.

Assignments
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Student
View Page

Description

Student
View Page

Description

Standards
Progress

The Standards Progress page shows a student’s
standards grades by reporting term. The column
that corresponds to the current term is
highlighted. Compare the grades the student
received in each term to assess his or her
progress. To view the assignments that you used
to assess the standard, click the number in the
Assignments column. Then use the graph at the
top of the page to see how the student performed
over time on the standard.

Observations

Use the Observations page to view all of the
observations you've created for the student. The
Observations page displays the title, location,
description, escalation status, and date of the
observation. Click the Edit icon to modify the
information for an observation.

Standards
Scoresheet

Use the Standards Scoresheet to view a student's
standards scores on all of the standards aligned to
assignments for a reporting term on a single page.
The Standards Scoresheet is similar to the Student
View in PowerTeacher Gradebook.

Assets and
Textbooks

Use the Assets and Textbooks page to view the list
of assets associated with the student. The Assets
and Textbooks page displays the asset title, the
description, the check-out and return dates, and
the status, such as In or Out. Associate an asset to
the student by clicking Check In/Out. View the
assets for the student’s other classes by clicking
the Gear icon and selecting Show Classes
Taught by Other Teachers.

Transfer
Scores

Use the Transfer Scores page to copy the
assignment scores from a student's dropped class
into a new class when that student transfers into
your class or moves between two sections of a
class you teach after the term has started. Use the
Transfer Scores page to copy scores from any
term, even if the previous term is locked. Copy
scores to any term, except to a locked term.

Comment Log

Use the Comment Log page to view all of the
comments you've recorded for a student.
Depending on the types of comments you've
entered for the student, the comment log may
show course grade comments, standards grades
comments, and assignment comments.

Demographics

Use the Demographics page to view a student’s
personal information, such as his date of birth or
mother’s phone number. Administrators may
choose to set up PowerSchool SIS so that you can
see the contact information from any student
contacts associated with the selected student.

Regardless of the district setting, some student
contact data will be available in PowerTeacher Pro
if the district has enabled the student contacts
feature. This includes email addresses, phone
numbers, employers, and original contact types, if
set. Your administrators can enable other contact
information.
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Student
View Page

Description

Quick Lookup
- Traditional

The traditional Quick Lookup page is the same
page that administrators see in PowerSchool SIS.
It shows the student’s attendance for the last two
weeks, his current schedule, his term grades, a
summary of his total absences and tardies, and his
current GPA. Click a grade to see the flags (colored
icons or indicators that represent common
assignment notes like “Late” and “Missing”) for the
student’s assignments and to see the standards
score information. Click the Standards icon to
view the standards aligned to an assignment.
Parents, students, and administrators will also see
this information for all PowerTeacher Pro sections.

Quick Lookup
- Standards

To view a student’s standards Quick Lookup page,
click Quick Lookup - Standards. Then click the
arrow next to one of the student’s classes to view
the standards aligned to the course and the
student’s standards final grades. Click a standard
final grade to view details about it. When a student
is graded on the same standard in multiple classes,
the student's final grades on that standard can be
averaged into one final grade—view the standard
grade rollup information on this page.

PowerTeacher
Portal

Click PowerTeacher Portal to view the selected
student’s screens in the teacher portal, which is
opened in a new window so that you don't lose
your place in PowerTeacher Pro. The screen that
appears depends on which screen you set up to be
the default student screen in the teacher portal.
For example, you may see the student’s Schedule
screen.

Viewing Individual Student Progress

To review an individual student’s performance:

1.

2
3.
4

7.
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At the top of the gradebook window, select a class
Click Students
To view the first student’s performance, click Assignments

Review the student’s course grades and individual
assignment scores, then open the Quick Menu and select
Standards Progress

Review the student’s standards scores for each reporting
term, then click the Assignments icon for one of the
standards

Review the graph of standards scores, then click Show
Metrics to review the student’s other standards statistics

= = Calculated : Most Recent 3

Click Students and select a different student to view his or
her Standards Progress page

23



PowerSchool SIS: PowerTeacher Pro Gradebook

Quick Reference Card

As outlined in the "Working with Final Grades" section of this
document, you can also view a student's Standards Progress
graphs directly from the Standards page by clicking a student's
standards grade, and then clicking the Graph icon in the Score
Inspector. Using the Standards page to view progress graphs is
useful when preparing for report cards.

Here are the definitions of the standards scores statistics that are
visible when you click Show Metrics below the graph:

e Most Recent - The average of the most recent score(s)
¢ Mean - The mathematical average of the scores

¢ Median - The middle of the scores (half of the scores are
above this number and half are below)

e Mode - The most common score achieved

e Weighted Mean - The average of the scores based on the
average of total weighted points

e Highest — The highest score

These statistical values are indicators of how well the student did
on a specific standard. If any of the values are low, it may mean
that the student needs additional practice on the skill or concept
that you're assessing, or you may need to revise the assignment.
To view the student’s performance on additional standards, open
the Quick Menu and select a standard.

The orange Professional Judgment Indicator may appear next to a
student’s standard score on the Standards Progress page when
evidence exists for mastery that may differ from the student’s
calculated standard score. To evaluate the student’s level of
mastery, click the Assignments icon next to the standard score.

Jll Curtis, Jared - Standards Progress

FT.VM.02 (+) Find the components of a vector by subtracting the coordinates

Grade Scale Type: (E - B)

TANDARDS ASSIGNMENTS

FT.VM.01 - (+) Recognize vector quantities as
having both magnitude and direction

A A 20 B
-’.\ =

Use your professional judgment to evaluate whether or not the
calculated score is a true indication of the student’s level of
mastery. For example, if the student was ill or had a bad test day,
his last score may not be a true indicator of his skill level, so you
could choose to ignore that score and change the calculated score.

Graphing Additional Standards or Metrics

To compare a student’s progress on up to four standards:

FT.VM.02 - (+) Find the components of a
vector by subtracting the coordinates

arXr aX
W

1. Click the Gear icon next to the term menu on the Standards
Progress page

Click Progress Options

In the Progress Options window, select the standards you
want to include in the comparison and click OK

4. Then, click the Show/Hide Graphs icon next to the Gear
icon to view the student’s progress on all of the selected
standards

5. Click one of the symbols, such as a triangle, on one of the
line graphs for a different standard to highlight it and view
the scores

6. Below the graph, view the calculated standard grades, the
metrics, the aligned assignments, and the scores for the
standards included in the comparison
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MAT.H.10.AG ~ | R ®|v
Graph polynomial functions

Standards Progress / AYALA, Frank

- - Calculated : Most Recent 3

Show Metrics 3- 3+ 3-
©)

Standard Grade
A

By default, the Standards Progress graph displays a green dotted
line that corresponds to the metric, such as Most Recent, used in
the standards grade calculation.

To add additional metrics to the graph:

1. Click the Gear icon next to the term menu on the Standards

Progress page
2. Click Progress Options

In the Progress Options window, open the Additional
Metric To Graph menu and select a metric, such as
Highest

4. Click OK

A gray dotted line appears on the graph, indicating the
score that corresponds to the selected metric.

10/14 10/27

8/9 9/10 10/3
— — Calculated : Most Recent3 ... Highest

Analyzing Class Progress

To analyze the performance of an entire class, begin by selecting
the class at the top of the gradebook window. Then, click
Progress. Depending on how the gradebook is set up, you can
view class progress on traditional grades and standards grades.
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Viewing Traditional Grades Progress

To view traditional grades progress:
1. From the Progress menu, select Traditional

The graph on the Traditional Grades Progress page shows
the distribution of grades for the class for the selected
reporting term. The horizontal black line shows where the
cutoff is between passing and failing grades. Click the
Information (i) icon to view the traditional grades included
in each color level. To the right of the graph, view a
summary of the total number of students who have missing,
late, or incomplete assignments.

1st Grade English (52)

s ) mising
0o 4 .

© 21 =
5 Orate

3 ]
3 N
' m 4 @ incomplete

4 @

7 View All

2. Click View All to open the Traditional Grades Distribution
window

3. On the left side of the Traditional Grades Distribution
window, view the grade distribution for each reporting term
in the school year
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On the right, view the grade trends of the students in the
class for the selected term, compared to the previous term

A red arrow in the Grade column indicates that the student’s
grade is trending down between the selected terms. A green
arrow indicates an upward trend, while no arrow indicates
no change. You can see which students are performing
better or worse between terms.

. To compare trends between a different selection of

subsequent terms, click a term in the Grade Distribution
column

Click the Information (i) icon to view the grades included
in each color level

. To close the window, click X in the upper-right corner

Traditional Grades Distribution E3

E 1st Grade English
Class grade trends in S2 compared against S1.
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Viewing Standards Grades Progress

To view standards grades progress:

1.

From the Progress menu, select Standards

The graph on the Standards Progress page shows the
distribution of grades for each standard aligned to the
course, for the selected class and reporting term. The black
line shows where the cutoff is between passing and failing

English
STANDARDS GRADE DISTRIBUTION (S2] ASSIGNMENTS

5 0|z B
3.RL.01 - Ask and answer questions to demonstrate understanding of a text 6

5 0|z 3
3RL.02 - Recount stories and determine the central message through key details 6

5 0 3
3.RL.03 - Describe characters in a story =z 8 E

5 0

” N
3.RL.04 - Distinguish between literal from nonliteral language [ 5 E

Click a graph to open the Standard Grades Distribution
window

On the left side of the Standard Grades Distribution window,
view the grade distribution for the selected standard for
each reporting term in the school year

On the right, view the grade trends of the students in the
class for the selected term, compared to the previous term

A red arrow in the Grade column indicates that the student’s
level of mastery is trending down between the selected
terms. A green arrow indicates an upward trend, while no
arrow indicates no change.

. To compare trends between a different selection of

subsequent terms, click a term in the Grade Distribution
column

6. To close the window, click X in the upper-right corner

Standard Grades Distribution nn

B Engish
3.RL.01 - Ask and answer questions to demonstrate understanding of a text
Standard grade trends in Q2 compared against Q1.

GRADE DISTRIBUTION STUDENT

Gaalswyk, Steven
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Young, Alyssa
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Heimsness, Tracy
Olsen, Bradley

Peterson, Chelsee

On the right side of the Standards Progress page, the number in
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the Assignments column indicates the number of assignments that
you've used to give students opportunities to practice the standard

or to assess their levels of mastery.
To view the assignments aligned to a standard:

1. Click the Assignments icon next to a standard

English

3.RL.01 - Ask and answer questions to demonstrate understanding of a text

2. On the Standards Assignment Trend window, click the name

of an assignment
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3. If needed, edit students’ scores in the column for the
selected standard and save the scores

Observations

Create observations as a way to record notes about students that
you can use to help in student performance analysis, such as
semester reviews.

To add an observation:
1. Click the Create icon
2. Click Observation

3. Enter a title for the observation, such as Improved
Participation Skills

4. Open the Student menu and select a student

The menu will include all students you teach, not just the
ones in the class you were working with on the previous

page.
Enter the location

Enter the date and time of the observation, or use the
default values of the current date and time

Enter a description of the observation

8. To submit the observation for review by an administrator,
check Escalate for review by administration

This option may not be available, depending on your
school’s settings. When this setting is checked, the
observation will be read-only, the information will become
part of a teacher referral incident for administrators to view
in PowerSchool SIS, and the reviewing administrator will
receive a notification of the observation.

9. C(Click Save

View and edit the observations you create by clicking Class and
selecting Observations. Change the selected class or group at the
top of the page to see their observations. Access the observations
for a student using the Students menu, or, when viewing a
student page, using the Student View menu and selecting
Observations.

Assets and Textbooks

Manage the distribution of textbooks and other assets by checking
the materials in or out. View and edit asset information at the class
or individual student level.

Managing Assets at the Class Level

To manage assets at the class level:
1. Click Class
2. Click Assets and Textbooks

3. Select a class or group from the menu at the top of the
page to see their assets and the check-in/check-out status

4. To record that a student has possession of an asset, click
Check In/Out

Select the student from the menu
Enter the asset tag, such as the textbook number

If configured, you can also scan asset tags.

7. Open the Condition When Checked Out menu and select
an option, such as Lightly Used

8. Add any notes about the terms of the checkout or the
condition of the asset
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9. Click Check Out

Managing Assets at the Student Level

To manage assets for an individual student:
1. Click Students
2. Click Assets and Textbooks

3. To view the assets associated with other teachers, click the
Gear icon and select Show Classes Taught by Other
Teachers

To check in an asset, click Check In/Out
Enter or scan the asset tag

Update the condition of the asset and add notes
Click Check In

N o u ok

Communicating with Students and
Contacts

If your district has enabled the email option in PowerSchool SIS,
then you can communicate with your students and their contacts
while reviewing assignments and grades. Keep in mind that emails
are sent to only students and contacts who have email addresses
listed in PowerSchool SIS and that emails are sent to only a
contact's primary email address. Also note that this feature should
not be used to communicate information related to student safety.

Emailing Students and Contacts

Send emails to your students and their contacts from within
PowerTeacher Pro to share information. Keep in mind that emails
can contain only plain text. If you need to send your students and
their contacts attachments, use the Copy Emails function to copy
the email addresses into a different email client.

The Create Email window also includes filter options you can use to
select specific students and contacts, such as only students and
their parents or guardians. To show or hide the filter, click the
Gear icon.

Filter types include:
e Type - Student and Contacts options
e Email - Has Email and No Email options

e Contact Type - Father, Mother, Guardian/Has Custody,
Emergency Contact, Receives Mail, and School Pickup
options

e Name - Search field
To send emails to students and/or contacts:
1. Click the Create icon
2. Choose Email
3. On the Recipients tab, select the class or classes
4

If needed, click the Gear icon and select Show Filter to
open the filter, then select from the options and click Apply
to filter the recipient list

5. To select all of the students in the selected class(es), check
the box at the top of the Students column, or select
individual students using the check boxes
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6. To select all of the associated contacts, check the box at the
top of the Contacts column, or select individual contacts
using the check boxes

Contacts are listed under the associated student's name in
the list of recipients, in the order in which they appear in
PowerSchool SIS (ex: the primary contact is first).

If you need to send an attachment, click Copy Emails, and
then paste the emails into a different email client that you
can use to send attachments.

7. Click the Message tab
Enter the subject of the email

9. In the Message text box, enter the body of your email
message

10. Check CC Me to send a copy of the message to yourself
11.Click Send

Running PowerTeacher Pro Reports

The gradebook contains reports that you can view onscreen or
print. Run each report by clicking Reports, selecting the report
name, and defining the report criteria and formatting options.
Personalize each report by entering a custom title or by including a
top note, bottom note, or signature line. The following table
provides brief descriptions of the reports:

Report Name

Description

Final Grades Report

e Use this report to print and
validate your final grades and

comments for your classes for the

selected term before submitting
grades to an administrator

e Use this report when an
administrator requires you to
submit a signed final grade and
comments verification report
during the End of Term process

¢ Include a signature line, points,
percentages, grades, and/or
comments

e Run the report as a PDF or an
Excel spreadsheet
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Report Name

Description

Individual Student
Report

Use this report to view or print a
summary of the class activity per
student

Include only one class or the
student's full schedule

Generate a report similar to the
Multi-Section Report in
PowerTeacher Gradebook that
includes scores for any course a
student or a whole class is taking

Include student numbers next to
student names for identification
purposes

Present a summary of student
work to parents at conferences or
to a principal during a review, or
use the report as a midterm
update for students and parents

Choose whether or not to include
course grades and attendance,
assignments, category totals,
standards scores, citizenship
scores, and comments

Print the report for a few students
or a group

Report Name

Description

Missing Assignment
Report

Use this report to create lists of
assignments that have not been
scored, have been marked with
the Missing flag, or both

Run the report for a selected term
by class or by student

Run the report as a PDF or an
Excel spreadsheet

Multi-Function
Assignment Report

Use this report to view or print a
list of students and scores per
assignment

Use it to find missing, late, or
incomplete assignments, to help
students and parents keep up with
class work, to target students who
need extra help, or to gauge
which assignments present the
most challenges to students

Scoresheet Report

Use this report to print a copy of
the Scoresheet page

Include final grades and
assignment scores

Use student numbers or names

Sort students by name, student
number, or randomly

Use it to post a printout of
students' grades

Run the report as a PDF or an
Excel spreadsheet
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Report Name Description

Standards Grades e Run this report to generate a
Report spreadsheet-style summary of
standards grades earned by
students in your classes

e View standards grades for all
reporting terms and assignments
that are within a specific date
range, for all students

e Include the standard identifier,
name, or both

e Run the report as a PDF or an
Excel spreadsheet

¢ Note: You can run the By
Assignment option for only one
class at a time

Student Roster e Use this report to view or print
demographic information by class

e Use the report, for example, to
keep track of money collected for
classroom field trips, or as an
emergency contact list

e Customize the report by adding
blank columns (the report
remembers the information you
entered last)

e Use the Order arrows to arrange
the columns in any order

e Run the report as a PDF or an
Excel spreadsheet
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Using the Report Queue

Navigate to the Report Queue to view reports you've generated.
Access the Report Queue by either clicking Reports in the
navigation menu and selecting Report Queue or clicking the
Notifications icon and selecting Report Queue.

Reports in the queue are listed by name and date. View the icons
in the Status column to see if a report is running, pending,
completed, cancelled, or if there was an error. Refer to the legend
for icon definitions.

To download and view a report, click the report name. To delete a
report, click the Delete icon (looks like a trash can) in the Actions
column. To rerun a report using the same settings you used to run
the original version, click the Information (i) icon in the Actions
column, then click Resubmit. To update the status of a running or
pending report, click Refresh.

Report Queue
REPORT NAME DATE \ A0 ACTION:
Field Trip Roster 12/4/2020 01:10 PM v ﬂ
Missing Assignment Report 12/4/2020 12:56 PM v @ ﬂ
Rows/Page \T\
Completed and canceled jobs will automatically be deleted after 30 days T
Legend
Icons ¥ - Cancelled |~ - Completed |0 - Error |© - Pending |esss - Running
Running the Individual Student Report
To run the Individual Student Report:
1. Click Reports
2. Select Individual Student Report
3. Enter a report title, such as Progress Report
reserved. 32
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4.

10.

11.

Copyright © 2021 PowerSchool Group, LLC or its affiliates. All rights reserved.

Open the Select Classes menu and choose the classes to
include on the report

. To use a previously customized class name, check Use

Custom Class Name

Since you are creating a progress report that includes
students' course grades in only your class instead of all of
their classes, leave the Include Students' Full Schedule
check box clear

Check Include Students' Full Schedule to create a multi-
section report that includes scores for any class the student
is taking.

In the Sort Options section, open the Layout menu and
choose By Section, By Student

. To sort the report by students’ last names, open the

Students menu and choose Last Name

To use the preference for how student names are sorted by
default in your gradebook that you defined under Settings
> Display Settings, choose Gradebook Preference.

Use the Assignments menu to sort the assignments by due
date or by category and due date

Open the Areas To Include menu and check Course
Grade Comments and Assighment Comments to include
any comments that you’ve entered about the students in
the report

Course Grades and Attendance, Assignments, and
Category Totals are checked by default. If citizenship
score entry is enabled, select Citizenship to include
citizenship scores.

Click the Areas To Include menu again to close it

12.

13.

14,

15.

16.
17.

18.

19.
20.

21.

22.

23.
24,

Verify that Show Percentages is selected to include
students’ grade percentages in the report

To help with identifying students with the same name, add
student numbers to the report by selecting Include
Student Number with Student Name

To include students’ grades from the current term, use the
default settings under Date Range

Use the default settings under Data Filters to include any
assignments, any scores, any category, and any course
grades

Open the Students tab

To run the report for a selection of students rather than for
all of the students in the classes, click Add/Remove
Students

All of the students are selected by default, so clear the
check box to the right of the Filter area, then in the list of
students, check the boxes next to individual student’s
names

Scroll to the top of the page and click the Format tab

Since you are including all of the available data in the
report, leave the page orientation set to Landscape to
make the text easier to read

Use the default option PDF for the report output

To create a page break between students, check Page
Break

Choose to exclude row shading to save ink during printing

Leave the Include check box clear for the Top Note option,
since you don't plan to include a note at the top of the
report
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25. Leave the Include check box clear for the Bottom Note Running the Missi ng Assign ment Report
option, since you don’t plan to include a note at the bottom
of the report To run the Missing Assignment Report by student:

26. Clear the Signature Line check box, since you don't need 1. Open the menu at the top of the gradebook window and
parents to sign the report select a class

27.To generate the report, click Run Report Click Reports

An alert at the top of the window indicates that the report is Select Missing Assignment Report

being processed. Enter a report title, such as S2 Missing Assignments

u s W

28.To open the Report Queue, click View Reports Since you selected a class before you navigated to the
Reports menu, use the class that is already selected for the
Or, click the Notifications icon—which has a red number Classes option

indicating the number of reports that are ready—and then

select Report Queue. 6. To include both the students' names and student numbers

in the report, open the Student Field menu and select
29.If the report is still running, click Refresh to update the Both

status 7. Under Sort Options, open the Layout menu to choose By

30.To download the completed report, click the report name Student so that the report will include one page per
student (rather than one page of all of the students who are
missing assignments in the class)

Progress Report (2918) Ainsworth, Cole

lases 24 Grad Englsh @020 2021 8. To sort the report by students' last names, open the

Final Grade Students menu and choose Last Name

— " - e R 9. To sort the list of missing assignments included in the

Standard Final Grade report by the most recent due date first, open the

Tt e — Assignments menu under Sort Options and choose Due
Rocount soriesand deerineth cntal mesage Brough ey deats " Date (Newest First)

10. Under Data, open the Assignments menu and select Both
to include both assignments that have not been scored and
the ones you've marked with the Missing flag

11. For the Categories menu, use the default selection to
include all categories of assignments in the report
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12.

13.

14,

15.
16.

17.
18.

19.
20.

21.

Under Date Range, open the Assignments menu and select
S2 to include missing assignments from Semester 2

Click the Students tab at the top of the page and verify
that the report applies to all of the students in the selected
class

Click the Format tab
Open the Orientation menu and choose Landcsape
Use the default option PDF for the report output

To work with the data in a spreadsheet, choose Excel.

Use the default settings for the rest of the format options
To generate the report, click Run Report

An alert at the top of the window indicates that the report is
being processed.

To open the Report Queue, click View Reports

If the report is still running, click Refresh to update the
status

To download the completed report, click the report name

Missing Assignment Report
Class: 2(A) 3rd Grade English

Due Date
06/24/2021

Filipi, Ross (2914)
Teacher Name: Dempsey, Jackie

Assignment Name Pts
Vocabulary Project 100.0
06/22/2021 Chapter 12 Review 250
03/31/2021 Chapter 10 Test 100.0
03/06/2021 Unit 3 Homewor k 250

Running the Student Roster Report

To run the Student Roster report for a class:

1.

u s W

10.

11

12.
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Open the menu at the top of the gradebook window and
select a class

Click Reports
Select Student Roster
Enter a report title, such as Field Trip Roster

Since you selected a class before you navigated to the
Reports menu, it is already selected for the Classes option

To sort the roster of students by last name, open the
Students menu and choose Last Name

. Add columns of student information by opening the Add

Columns menu next to Student Columns and clicking Add
next to Gender and Grade Level

Click Add next to Blank twice to include a column for taking
attendance and one for tracking participation

A column titled "Name” is included by default to list the
students’ names.

Click the Add Columns menu again to close it

Enter Attendance as the title of the first blank column

.Enter Participation as the title of the second blank

column

Add columns of contact information by opening the Add
Columns menu next to Contact Columns and clicking Add
next to Contact Name and Contact Phone

Note that the contact options are determined by the district-
level settings.
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13. Click the Add Columns menu again to close it

14. Open the Filter Contacts menu and select the contact
type, if desired

15. Click the Students tab at the top of the page and verify
that the report applies to all of the students in the selected
class

16. Scroll to the top of the page and click the Format tab
17.Open the Orientation menu and choose Portrait
18. Use the default option PDF for the report output

To work with the data in a spreadsheet, choose Excel.
19. Use the default settings for the rest of the format options
20.To generate the report, click Run Report
An alert at the top of the window indicates that the report is
being processed.
21.To open the Report Queue, click View Reports

22.1If the report is still running, click Refresh to update the
status

23.To download the completed report, click the report name

Field Trip

Name Gender Grade Attendance Participation
AYALA, Frank M 12

BAILEY, MacDonald M 12

BERGER, Harvey M 12

CASE, Shaniqua F 12

CASEY, Headroom F 12

CLINE, Matt M 12

COBB, Hunter F 12

FRIEDMAN, Bennet F 12
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